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'Application Note Automatic Report Generation

Avutomatic Report Generation in Artemi$

The report generation function of ArtemiS allows users to have measurement reports created
automatically, which can then be saved or printed. A basic form of the automatic report genera-
tion is available with the base version of ArtemiS. It is described in the first part of this Applica-
tion Note. The second part covers the advanced version, which allows, for example, custom
templates to be created.

Report Generation with the ArtemiS Base Version

Template Configuration

Before reports can be generated automatically in ArtemiS, the layout of the analysis results must
be specified in a template'. To do so, use the configuration mode of the Report Generator ele-
ment placed into the Destination Pool. Figure 1 shows an example project. Five sound files have
been placed into the Source Pool, of which only one is activated for the configuration mode for
now. Furthermore, two analysis functions have been included and activated in the project.
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Figure 1: Example project

Figure 2 shows the Properties dialog of the Report Generator element with the configuration
mode activated. The Properties dialog also allows you to specify the number of ArtemiS dia-
grams included in the report to be generated. This is done in the form of a matrix, for which you
can specify the number of columns and rows. In our example with a two-channel sound file and
two active analysis functions, a 2 x 2 matrix is a natural choice.

" In the following, the term “template” refers to a Microsoft Word® document with the file name extension “.doc”,
which contains placeholders for ArtemiS diagrams.
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Figure 2: Properties dialog of the Report Generator element with activated configuration mode

Clicking on the Calculate button starts the configuration mode. In this mode, the left side of the
screen shows a directory structure listing the audio signal and below it the results of the analysis,
and the right side shows a Word template, into which the analysis results can be inserted (see

figure 3).
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Figure 3: Configuration mode of the Report Generator
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Once an entry has been selected in the results list, the column labeled “Shown in” shows all the
possible diagram positions. The selected diagram position is shown next to the respective analy-
sis result. Figure 4 shows an example for such a layout specification.
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Figure 4: Layout specification for the analysis results

In the layout specification for the analysis results, it is possible to combine the data of several
two-dimensional analyses into one diagram, as long as they all have the same unit of measure-
ment. The results of three-dimensional analyses should always be shown in separate diagrams.
In the first position of the results list, you will always find the original audio signal. It can be
shown in a diagram as well.

The list also shows the display options for the curves, such as the color, the line thickness and
line type. These parameters refer to the display of two-dimensional results. For example, it is
advisable to use different colors if several two-dimensional curves are to be displayed in the
same diagram. To change a color, click on the black color box with the left mouse button (see
figure 5).
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Figure 5: Dialog for changing the curve color
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Once the curve properties and the diagram positions are specified, you can preview the layout
in the template by clicking on the “Apply” button. This is only for checking the selected seftings.
When all settings are done according to the requirements, exit the configuration mode by click-
ing on the “OK” button. The created template can be saved as a Word document with the “Save
as” command. That way, the first report is already completed.

Report Generation Using the Preconfigured Template

All other reports can now be generated in a batch process based on the template created be-
fore. To do so, disable the configuration mode in the Properties dialog of the Report Generator
element. In addition, you can specify a number of options for the batch process. Figure 6 shows
the Properties dialog with the configuration mode disabled.
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Figure 6: Properties dialog of the Report Generator

In the lower part of the Properties dialog, you can specify how the channels are identified. Select
“Numbers” for a layout that is based on the channel number, or select “Name” for a layout
based on the names of the channels. The following example illustrates the difference: In config-
uration mode, the first channel of a file is shown in the first diagram and the second channel in
the second diagram. Let’s assume that the name of the first channel of the file used in configura-
tion mode is “mic_lower”, and the name of the second channel is “mic_upper”. With the setting
“Identify channels by number”, the subsequent batch process will always display the first channel
in the first diagram and the second channel in the second diagram. With the setting “Identify
channels by name”, the channel named “mic_lower” will always be displayed in the first dia-
gram and the channel named “mic_upper” in the second diagram. If the report generation pro-
cess encounters a file that does not contain a channel named “mic_lower”, the first diagram in
that report will remain empty.

Below the channel identification option, you can choose into which form the diagrams are to be
inserted in the report. If the option “Unlink diagrams” is enabled, the diagrams will be inserted
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into the report as graphics objects. Otherwise, the analysis results will be inserted as active dia-
grams, which can be configured just like in ArtemiS, for example to change the scaling of the
axes. To ensure this functionality, the original file must be available under the specified channel
name and file path when the report is opened. This means that the report cannot be displayed
easily on another computer. If the “Unlink diagrams” function diagrams is enabled, it is no
longer possible to make major edits to the diagrams, but it allows the reports to be displayed on
other computers. Furthermore, in that case the reports are displayed correctly even if the file
structure on the computer has been modified.

In the last section of the Properties dialog, you can specify what should be done with the finished
reports. You can choose to open the reports, to save them or to print them. If the “Open” option
is selected, the reports are only shown on the screen. You can then save selected reports using
the “Save as” command in the “File” menu. The “Save to” option causes all generated reports
to be saved automatically under the specified file name. The “Print” option prints all reports on
the printer connected to the computer.

When the settings described above have been made in the Properties dialog, the report genera-
tion can be started. To do so, place all the files you want to generate a report for, into the
Source Pool, activate them and start the calculation.

The following should be considered when generating reports:

« The layout specification for the analysis results in the template diagrams is saved within
the Report Generator element of the project. If you want to reuse the diagram layout for
other sound files in the future, the project with the Report Generator element must be
saved.

« The number and layout of analyses in the project should be saved as well. The infor-
mation contained in the Report Generator element only specifies that, for example, the
results of the first analysis should be displayed in the first diagram etc. If the type of anal-
ysis is changed in the Analysis Pool, this automatically affects the display in future reports
as well. That way, the reports can easily be adapted to meet new requirements. To make
sure that the reports are always generated in the same way, the items in the Analysis Pool
and the Destination Pool can be protected. To do so, use the “Lock” command in the
context menu of the respective item and specify a password for making modifications to
the item (see figure 7, next page). After this the ArtemiS project has to be saved.

 The axis range shown in the report can be configured on the Property Page (“representa-
tion” tab) of the respective analysis. By using “Fix range” the axis range is fixed and used
for every following report. Thus the results can be easily compared to each other. The
“Fix range” setting is retained by saving the ArtemiS projects and can be protected with
the “Lock” command.

* A report can also be used to compile the results for several sound files. To do so, acti-
vate several files in the Source Pool for the template configuration. The results list in con-
figuration mode then contains the audio signals and the analysis results of all activated
files. For the subsequent calculation, the sound files are combined in the report accord-
ing to the number specified in configuration mode.
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Figure 7: Password protection of elements used in the project pools

Advanced Report Generation with the ArtemiS Tool Pack ATP 11

Template Configuration

With ATP 11, in addition to the template creation method described above, it is also possible to
create and use your own custom templates. These templates can include, for example, your
company logo and custom text modules, such as the current date. The Artemi$ installation folder
contains some example templates. These can be used as a basis for creating your own tem-
plates. The names of the included example templates differ in their first letter: “L” or “P”. The
letter “L” stands for landscape format and “P” for portrait format. The numbers in the template
names refer to the layout of the diagrams. This means that, for example, the template
“L2x3.doc” contains a matrix of 2 x 3 diagrams in landscape format.

To customize your templates, first open them in Microsoft Word®. Using the normal editing func-
tions offered by Word, you can adapt the design according to your needs. For example, you can
extend the table containing the diagrams, so that it can also accommodate your company logo
and name. Figure 8 shows such an edited template. In addition to the diagram objects, the ta-
ble now also contains a line with company logos and a field into which Word automatically in-
serts the current date. Such a field can be included into the table using the “Field” command in
the “Insert” menu. In addition, the word “File name” has been entered. After this word, ArtemiS
will insert the name of the respective sound file when generating the report.

06/11 6
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Figure 8: Editing a template with Microsoft Word®

Using the command “Insert” -> “Object” -> “HEAD Diagram Control” you can also insert ad-
ditional diagrams in order to display additional analysis results. With this command, you can
also create new templates from scratch, which need not be based on the included example tem-

plates and can contain several pages.

Once a template has been created according to your individual needs, you can save it with the

“Save as” command and use it in ArtemiS.

Report Generation Using the Saved Template

In ArtemiS, open the Properties dialog of the Report Generator element and enter the path and
file name of your saved template in the corresponding field. Clicking on the button with the
three dots opens a file selector dialog, where you can browse for your Word file. In order for the

template to be used, the radio button next to the file name field must be active.

06/11
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Figure 9: Selecting a saved template for the report generation

For the advanced report generation it is again necessary to start with the configuration mode to
specify the diagram layout. This is done as described before. Just like in the base version, this
layout specification is then saved in the Report Generator element of the ArtemiS project.

In addition to the layout of the analysis results, you can also specify additional written infor-
mation about the data files. This includes, for example, the name of the data file, the single-
number value of the analysis, or information saved with the file as comments.

To insert this information, the view in configuration mode must be switched from “Channels” to
“Variables”. In this view, the list of analysis results is replaced by a list of available variables. To
insert one of these variables into the template, the cursor in the Word document must be placed
in the desired position. Then click on the desired variable in the list with the left mouse button.
The variable immediately appears in the chosen position in the Word document. Figure 10
shows an example.
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Figure 10: Inserting text variables

As soon as all desired variables have been inserted, the changes can be saved as a new tem-
plate with the command “Save Template as” in the “File” menu. Unlike the diagram layout,
which is saved with the Report Generator element in the ArtemiS project, the inserted variables
must be saved in the actual Word template.

When the configuration of the template is complete, it can be used just like the standard tem-
plates for the automatic report generation.

In order to use a report template repeatedly in the same way, the ArtemiS project with the con-
figured Report Generator element and the properly defined analyses must be kept available
(preferably in locked mode). In addition, in order for the advanced report generation functions
to be used, the Word template to be used must be available on the computer under the file path
specified in the Report Generator element. That way, standardized reports that are directly com-
parable to each other can be created quickly and easily.

Notes

For the applications described in this Application Note, you need the ArtemiS base version (code
4600); the advanced report generation requires the ArtemiS Tool Pack 11 (code 4611).

Do you have questions for the authore Contact us at imke.hauswirth@head-acoustics.de.
We look forward to your feedback!
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